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Welcome to MAGic 
MAGic is a software solution ideally suited for computer users with low 
vision, or anyone who spends extended periods of time in front of a 
computer screen. 

MAGic lets you magnify your computer screen from 1 to 16 times its 
usual size. You can choose from a number of different adjustable views 
that let you see both a magnified and unmagnified portion of the screen 
at the same time. 

Speech features assist you in processing the information on your screen. 
MAGic can read text that you type or point at with the mouse. MAGic 
moves the magnified area of the screen so you always see the text 
being read and highlights words as they are spoken.  

Mouse and cursor enhancements help you track the location of the 
mouse pointer and cursor on the screen. You can choose from a wide 
variety of enhancement styles. MAGic lets you change the color of these 
enhancements, apply transparency effects, adjust their size, and more.  

Color enhancements let you change how colors display on your screen. 
You can create rules that replace one color with another or switch two 
colors. You can also apply color tinting, make your screen black-and-
white (monochrome), and invert the brightness and colors of your 
display. 

Other MAGic features track elements of your screen, such as the mouse 
pointer, dialog boxes, and so on. The Locator feature provides you with a 
way to quickly find and move to different areas of the screen. The MAGic 
multi-directional panning system gives you complete control with 
adjustable speed, direction, stop and start, and screen navigation 
controls. 
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System Requirements 
The recommended system requirements for MAGic are listed below.  

Specification Minimum Requirement 

MAGic Standard Windows 95/98/ME/2000/ 
XP Home* 

MAGic Professional Windows 95/98/ME/NT/ 
2000/XP Home and Pro* 

Processor speed 166 MHz 

RAM 64 MB 

Available hard disk space 75 MB 
for installation 

Available hard disk space 45 MB 
after installation 

Video 256 color graphics** 

Sound Windows compatible sound card (for 
speech option) 

* Some MAGic features are not available for Windows 95/98/ME users.  

** While MAGic will work with 256 colors, it is recommended that you 
use high or true color depth (16-bit color or higher). 

Installing MAGic 
1.	 Insert the MAGic CD into your CD-ROM drive. 

2.	 The MAGic Setup program starts. You will hear the installation 
speak the instructions as they appear on your screen. Follow these 
instructions to complete the MAGic installation. 
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If your MAGic installation CD does not start automatically, click the Start 
button, select Run, and type D:\setup. If your CD-ROM is not D, 
substitute the correct drive letter. 

The MAGic setup program will then begin. Choose to run the automatic 
or guided installation of MAGic. The automatic installation assumes that 
you want to install all languages and you approve of the default location 
where MAGic is stored on your hard disk. Use the guided installation if 
you want to specify which languages to install, where MAGic is stored on 
your computer, or whether MAGic should start automatically when you 
start Windows. 

To uninstall MAGic go to the Program menu and select the Uninstall 
MAGic option in the MAGic submenu. 

Starting MAGic 
MAGic gives you a variety of ways to start the program. 

•	 Press the hot key, ALT+CTRL+M, which is automatically assigned 
when you install MAGic. 

•	 Double-click the MAGic icon on your desktop.  

•	 From the Start menu, choose Programs, open the MAGic submenu, 
and choose MAGic. 

After you start MAGic for the first time, you can choose to run the 
program when Windows starts. To do this, open the File menu, choose 
Preferences, and select the Run MAGic at Startup check box. 

Quitting MAGic 
To quit MAGic, do one of the following: 

•	 Press ALT+F4 

•	 Click the  in the top right hand corner of the window.  

•	 Select Exit from the File menu.  

Tip: 	 If you want MAGic to ask you to save your settings when you 
quit, open the File menu and choose Preferences. Select the 
Prompt to Save Settings on Exit check box. 
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Getting Started 
Start MAGic by pressing ALT+CTRL+M or by double-clicking the MAGic 
program icon on your Windows desktop. You can also start MAGic by 
opening the Start menu, choosing Programs, MAGic and then selecting 
MAGic. 

Tip: You can change how and when MAGic starts by opening the 
File menu and choosing Preferences. 

When you first start MAGic, your screen is displayed in 2× magnification 
using the Full view. Speech will also be enabled. You can change the 
magnification level, magnified view, speech, and many other options by 
using the MAGic user interface. 

The user interface is a small window that appears in approximately the 
center of your display. This window allows you to control all aspects of 
MAGic and contains the magnification and speech buttons in addition to 
the MAGic menu and title bars. The user interface is shown below. 
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Magnification and Speech Buttons 
One of the first things you will notice about the user interface is the 
rows of blue and orange buttons. The blue buttons control magnification 
features while the orange buttons control speech. Below are brief 
descriptions of each button. 

Button Function 

Use the Magnification button to enable or disable 
magnification. 

The current magnification level can be adjusted with 
the two Magnification Level buttons. The number in 
the between the two buttons shows the current level. 

Use the Mouse Enhancements button to 
enable/disable enhancements and modifications for 
your mouse pointer. These enhancements make the 
mouse pointer easier to track and maneuver on your 
screen. 

5 



Button Function 

Use the Cursor Enhancements button to 
enable/disable enhancements for your cursor. These 
enhancements make the cursor easier to follow when 
editing or writing text. 

Use the Colors Enhancements button to enable/disable 
color enhancements. This feature allows you to 
replace colors, adjust the brightness and contrast, 
apply tinting, blend colors, and invert the brightness 
and colors of your display.  

Use the Locator button to enable/disable the Locator 
function. The Locator function allows you to find items 
on your screen.  

Use the Smoothing button to enable/disable 
smoothing. This feature smoothes the appearance of 
jagged letters in a magnified state.  

The Resize View button allows you to change the 
dimensions of your magnified view. 

Select your preferred magnified view from the 
Magnified Views list. 

Use the Speech button to enable or disable speech. 

Use the Mouse Echo button to toggle the mouse echo 
feature on and off. The mouse echo feature enables 
MAGic to read text that you point at with the mouse. 

Use the Typing Echo button to enable or disable the 
typing echo. If typing echo is enabled, MAGic 
announces the words or characters you type. 
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MAGic Menus 
Located above these buttons is the menu bar. The menu bar allows you 
to customize speech, magnification, and your keyboard. You can also 
view help information and perform other functions. Each menu is 
described below. 

Menu Purpose 

File The File menu allows you to save your settings, 
restore the original Freedom Scientific settings, and 
change your MAGic preferences. 

Magnification The Magnification menu allows you to customize 
how you view your screen with MAGic. You can also 
change mouse options, panning settings, view 
properties and more. 

Speech You can customize MAGic’s speech components to 
fit your particular needs. The Speech menu allows 
you to customize how you hear MAGic. 

Keyboard The Keyboard menu allows you to customize how 
you use your PC's keyboard with MAGic. You can re­
assign the MAGic Key to a different key and manage 
shortcut keys. 

Help The Help menu provides you with detailed help 
information for the various MAGic functions and 
options. You can also view information on the 
newest features for this release and see your 
current MAGic version. 

The MAGic Key 
The MAGic Key is the CAPS LOCK key on your keyboard. Pressing the 
MAGic Key in combination with other keys activates a number of MAGic 
commands. If you want to assign the MAGic Key to a different key on 
your keyboard, open the Keyboard menu and choose MAGic Key. 
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Reading Text with MAGic 
MAGic can use synthesized speech to read text that appears on your 
screen, including documents, menus, dialog boxes, e-mail messages, 
Web pages, and more. Additionally, MAGic can highlight the text as it is 
spoken. To customize MAGic’s speech, use the commands available on 
the Speech menu. 

Tip: You can silence MAGic’s speech at any time by pressing CTRL. 
To toggle speech on or off, press MAGic Key+F3. 

Using the Mouse to Read Text 
Mouse echo is a feature that allows you to read text with your mouse. 
To use mouse echo, just move your mouse pointer to some text on your 
screen and then stop. After a short delay, MAGic will speak the word you 
pointed to. You can use the Mouse Echo button to enable or disable this 
feature. 

Using the Keyboard to Read Text 
MAGic has a number of different keystrokes that let you use the 
keyboard to read text. To use these keystrokes, move your insertion 
point or mouse pointer to any location within the document. Then press 
one of the following key combinations to read from that location: 

•	 To begin reading from your current location, press MAGic 
Key+SPACEBAR. 

•	 To read the current word, press MAGic Key+ALT. To spell the 
current word, press MAGic Key+ALT twice quickly. 

•	 To read the current line, press MAGic Key+L. 

•	 To read the current sentence, press MAGic Key+S. To read the next 
sentence, press MAGic Key+SHIFT+S. 

•	 To read the current paragraph, press MAGic Key+P. 

•	 To begin reading a column of text from your current location, press 
MAGic Key+C. 
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•	 To read any connected words with the same foreground and 
background colors, press MAGic Key+CTRL. You can use this 
command to read text that you have selected. 

•	 To hear the contents of the Clipboard, press MAGic Key+X. 

Note: 	 By default, the MAGic Key is assigned to the CAPS LOCK key. 
To change this, open the Keyboard menu and choose MAGic 
Key. 

When you read text with these keystrokes, MAGic highlights the word it 
is currently speaking. To change the color and/or style of this 
highlighting, open the Speech menu and choose Document and Text 
Reading. 

Getting Help 

Online Help System 
To access MAGic’s online help system, select Help Topics from the Help 
menu, which is located on the menu bar of the MAGic application 
window. Use the Table of Contents to navigate the help system. Use the 
Index or the Find tabs to search for specific topics within the help 
system. If you want MAGic to read the help topics to you, position the 
mouse pointer at the beginning of the help page, and press MAGic 
Key+SPACEBAR. To move to the next topic, press the PERIOD key, and, 
to move back a topic, use the COMMA key. Additionally, the Back button 
will take you directly back to the topic you read prior to the one 
currently displayed. 

What’s This? Help 
MAGic’s What’s This? help is context-sensitive help that you can use as 
a reference when working with MAGic’s user interface or dialog boxes. 
Press SHIFT+F1 on any button on the user interface, or control in a 
dialog box to see a brief description of the purpose of the control and 
how to use it. 
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MAGic User’s Guide 
We provide you with the content of the MAGic online help system in the 
MAGic User’s Guide, which is printed in large text for easier reading. 
This book contains detailed descriptions of MAGic’s features, and also 
pull-out reference cards. 

Technical Support 
If you do not find the answers to questions or problems that you have, 
contact Freedom Scientific Technical Support, (727) 803-8600. 

About MAGic  
Select About MAGic from the Help menu on the MAGic user interface to 
view the version number of MAGic you are currently running. 
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MAGic Hot Keys 


General 
Start MAGic ALT+CTRL+M 

Minimize/Restore the MAGic User MAGic Key+NUM PAD ASTERISK 
Interface 

Pass Through Key MAGic Key+3 

Refresh Screen MAGic Key+ESC 

Magnification, Views, & Enhancements 

MAGic Key+NUM PAD PLUS or 

Increase Magnification  CTRL+EQUALS 

MAGic Key+NUM PAD MINUS or 
Decrease Magnification CTRL+DASH 

Magnification Toggle On/Off MAGic Key+DELETE 

Toggle between 1x Magnification MAGic Key+DELETE+SHIFT 

Switch between Magnified Views MAGic Key+NUM PAD SLASH 

Toggle Color Enhancements On/Off MAGic Key+F12 

Toggle Cursor Enhancements On/Off MAGic Key+F8 

Toggle Mouse Enhancements On/Off MAGic Key+F4 

Panning and Screen Movement 

Pan Right 
or 

Key+NUM PAD 6 

Pan Left 
MAGic Key+LEFT ARROW or MAGic 
Key+NUM PAD 4 

MAGic Key+RIGHT ARROW MAGic 
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MAGic Key+DOWN ARROW or MAGic 
Pan Down Key+NUM PAD 2 

MAGic Key+UP ARROW or MAGic 
Pan Up Key+NUM PAD 8 

Increase Speed during Panning NUM PAD PLUS 

Decrease Speed during Panning NUM PAD MINUS 

Move to Left Edge of Screen in 
Magnified View MAGic Key+HOME 

Move to Right Edge of Screen in 
Magnified View MAGic Key+END 

Move to top of Screen MAGic Key+PAGE UP 

Move to Bottom of Screen MAGic Key+PAGE DOWN 

Move to Beginning of Next Line MAGic Key+ENTER 

Tracking 

MAGic Key+R 

Reposition Mouse MAGic Key+NUM PAD 5 

Tracking Toggle On/Off  

Locator Mode 

Start Locator MAGic Key+F10 

Stop Locator ESC 

Move Left LEFT ARROW 

Move Right RIGHT ARROW 

Move Up UP ARROW 
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Move Down DOWN ARROW 

Move to End of Line END 

Move to Beginning of Line HOME 

Move to Top of Screen PAGE UP 

Move to Bottom of Screen PAGE DOWN 

Quick View Frame 

Toggle Quick View Frame On/Off MAGic Key+Q 

Set upper left corner of frame MAGic Key+LEFT BRACKET 

Set lower right corner of frame MAGic Key+RIGHT BRACKET 

Create frame around current dialog MAGic Key+LEFT BRACKET twice 
box option quickly 

Open Quick View Manager MAGic Key+9 

Speech 

Silence Current Speech CTRL 

Enable/Disable Speech MAGic Key+F3 

Language Toggle MAGic Key+F11 

Note:	 On multi-language systems, the primary language by default is the 
language of the operating system. When you choose a second 
language, use MAGic Key+F11 to toggle between the primary and 
secondary language. To set another language, do so in the Voices 
dialog box, activated from the Speech menu on the MAGic user 
interface. 

Document Reading 

Read All from Location MAGic Key+SPACEBAR 

13 



Read Active Window (reads from the 
beginning of document window)  MAGic Key+SPACEBAR (twice) 

Say Title Bar MAGic Key+T 

Read Column from Current Position MAGic Key+C 

Text Reading 

Say Current Color Block MAGic Key+CTRL 

Say Current Word MAGic Key+ALT 

Spell Current Word MAGic Key+ALT (twice) 

Say Current Line MAGic Key+L 

Say Current Sentence MAGic Key+S 

Say Next Sentence MAGic Key+SHIFT+S 

Say Current Paragraph MAGic Key+P 

Say Contents of Clipboard MAGic Key+X 

Note: 	 When using the document and text reading commands, if you move 
the mouse MAGic reads from the current location of the mouse 
pointer. If you move the insertion point, MAGic reads from the 
location of the insertion point. 

Typing Echo 


MAGic Key+F2 
Toggle announcement of uppercase 
letters on/off 

Mouse Echo 

MAGic Key+MMouse Echo Toggle 
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Note: Toggling the mouse echo rotates between speak lines, speak words, 
and mouse echo off. 

Some actions in MAGic do not have hot keys assigned. You can define hot 
keys for many of these features from within the Keyboard Assignments dialog 
box. 
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Windows Shortcut Keys 


General 
Get Help F1 

Open the Start menu WINDOWS Key or CTRL+ESC 

Open Windows Explorer WINDOWS Key+E 

Open the Run dialog box WINDOWS Key+R 

Find file or folder from Desktop F3 

Minimize all windows WINDOWS Key+M 

Switch between programs ALT+TAB 

Quit the active program ALT+F4 

For Windows and Menus 

Open the application control menu ALT+SPACEBAR 

Move to the menu bar ALT 

Choose a menu command ENTER 

Move between menus ALT, arrow keys 

Close a menu ESC 

Close a cascading menu ALT 

Open a child window control menu ALT+HYPHEN 

Close a child window CTRL+F4 

Open the context menu APPLICATION Key or SHIFT+F10 
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For Dialog Boxes 

Move through dialog box options TAB 

Move backward through dialog box 
options SHIFT+TAB 

Move to another tab CTRL+TAB 

Reverse direction through tabs CTRL+SHIFT+TAB 

Move to first option HOME 

Move to last option END 

Select or clear an item in a list SPACEBAR or CTRL+SPACEBAR 

Select or clear a check box SPACEBAR 

For Reading Text 

Move left one character LEFT ARROW 

Move right one character RIGHT ARROW 

Move left one word CTRL+LEFT ARROW 

Move right one word CTRL+RIGHT ARROW 

Move to beginning of line HOME 

Move to end of line END 

Move up one paragraph CTRL+UP ARROW 

Move down one paragraph CTRL+DOWN ARROW 

Scroll up one screen PAGE UP 

Scroll down one screen PAGE DOWN 

Move to beginning of document CTRL+HOME 

Move to end of document CTRL+END 
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For Editing Text 

Copy CTRL+C 

Cut CTRL+X 

Paste CTRL+V 

Undo CTRL+Z 

Delete character to the left BACKSPACE 

Delete character to the right DELETE 

Select one character left SHIFT+LEFT ARROW 

Select one character right SHIFT+RIGHT ARROW 

Select one word left CTRL+SHIFT+LEFT ARROW 

Select one word right CTRL+SHIFT+RIGHT ARROW 

Select to beginning of line SHIFT+HOME 

Select to end of line SHIFT+END 

Select to beginning of document CTRL+SHIFT+HOME 

Select to end of document CTRL+SHIFT+END 

Select all CTRL+A 

For Windows Explorer 

Delete selected file or folder DELETE 

Rename selected file or folder F2 

Open properties ALT+ENTER 

Refresh a window F5 

Switch between panes F6 or TAB 
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BACKSPACEGo up a level 
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